
Multimedia Builder 1.3
Creating professional interactive multimedia application is easier than ever!
If you need to develop creative multimedia projects without having to spend months learning how to use authoring software -    
Multimedia Builder (MMB) – the visual multimedia authoring tool – is for you.

You can create FAST and SIMPLE :
 Autorun CD browsers (menus) for corporate CD-ROMs.
 Tutorials
 Cue Cards
 Kiosks
 and much more …

It is simple
No scripting or programming is required.
MMB visual click-to-create object oriented environment makes it easy to create a professional multimedia creations in minimal time 
and at low cost.
MMB integrate text, graphics, sound and video objects. Actions can execute programs, play sounds, video, jump to your web site, 
browse CD ROM, display document, Help file, send email and much, much more.

Multiple Pages
You can build your multimedia by creating one or more pages. On each page you combine text, buttons, graphics, hot spots,    
video    and actions into an interactive production.

Unique features
Custom Shape Window
MMB is unique. It allows you to create window on the desktop with custom shape. It means you don’t have to make your 
creations inside a standard rectangular window. With MMB you can create any shape you like ! 
See the picture .
Sound
MMB has the ability to play more than one sound at the same time. This is a huge advantage and can give your programs the 
appearance of much more activity. You can play background music in the loop and on the same time play other sound actions. 
This is based on Microsoft’s DirectSound technology. Even if your customer doesn’t have DirectSound he/she will be able to 
hear Sound Actions through standard Windows sound output.
Video
You can play video at any speed, and you can provide the user with many controls to control the video.

See the list of features .

See What  ’  s new   ?



Align Object
Multimedia Builder provides controls that allow for alignment of any series of objects. 
Use align tool to line up your objects precisely – on the left, right, top, or bottom.
Before we can align objects, we need to select the objects we wish to align.

 Click to select the first object
 Hold down the Shift key, and select the next object
 Repeat until all objects are selected

or
 Click somewhere near, but outside the objects you wish to align. As you drag, the rectangle appears.
 Drag the mouse around the objects, and unclick . 

Now use any of the alignment tool..

 



Group
Grouping is effective for protecting and maintaining connections and relations between objects. The Group command lets you 
lock those objects together to form what appears as a single object. You can then select the grouped objects and move, copy or 
hide the entire group.

To create the group:
 Select all the objects you want in the group
 Chose Group from the Arrange menu (or CTRL+G) to create the group

Ungrouping objects
 Select the group
 Choose Ungroup command from Arrange menu (or CTRL+U)

In the group you still have access to the properties of each object through Group Properties. 
Group objects together if you want to prevent accidental changes to related objects.
The group command also lets you create nested groups – groups composed of objects or groups of objects.

To select and group object by the name of the object use Group Manager command.

Add to Group
In order to add an object to some existing group select the object hold down SHIFT and select the desired group. 
Click Add to Group button or from menu Arrange select Add to Group.
You can also add a group into another group the same way, but remember to select firstthe object you want to add and then the 
group where you want to place the object.

Remove from Group
You can remove (ungroup) single object from the group. Select the object inside the group in the Object list and press Remove from 
Group button.



Custom Shape Window



Autorun CD Browser
Autorun CD browser provides a graphic interface for your CD-ROM files and your product setup.

 it makes the setup process more enjoyable. Impress your customers by using graphics, video and sound
 you can market other applications by providing product information within the CD browser
 provide contact information for your company, email and link to your web site



List of Features
 WYSIWYG design
 Object Oriented environment
 No scripting to learn, just click-to-create objects and actions
 Support of all popular graphic formats
 Multiple Undo/Redo
 Grouping and Ungrouping objects, nested grouping, add to groups
 Alignment tools
 Blending graphics with background
 Alpha Transparency Masks for blending
 Multiple sound channels 
 24-bit color
 Optimized performance
 Real Glow and Drop Shadow
 Effects: Sharpen, Blur, Flip
 Background Bitmap Tiling
 Background sound can play across page boundaries, looping
 Objects are in layers
 Define your own graphic buttons, save, load to/from library
 Window doesn’t have to be rectangular – support for custom shapes and library – tracing from image
 You can directly paste graphics from your graphic editor into the MMB without saving
 Video can be played on any speed
 Fade out effect
 Wizard for objects and actions
 Create Stand –Alone projects
 Bargain price



Text Properties
Texts are integral to the design of any multimedia. You will use text object to display headlines, body text or any other words that 
will be appearing on the screen.

Text can be active or inactive.
Label: Unique string represents this object. This is the name you will use for interaction with other objects.
Hide: Hide object. Object will be not visible for the viewer and no object’s actions will be trigged.    

Font: Open the font dialog
Align: Align the text to Left, Center or Right.

Enable the actions: enable the object trigger some actions
Color Interaction: If actions are enabled, text can change the color when mouse move over or user click on the text.
Actions Buttons: See the actions .

Note:
For longer texts and paragraphs use Paragraph Text object instead.



Bitmap Object
Bitmap object can be active or inactive object.
Bitmap object can be build from two parts.

Image
You can make any one color used in the image appear transparent, that is, the scene background will show through it, whatever 
that background is.
To make one color of the image transparent check Transparent color and select the desired color in color box.
To get the color of the top left pixel in the image – click color box and select automatic from the color box.
The transparent color is different from Alpha transparency – it can be only transparent or not, nothing in between.

Transparency Map (Alpha transparency)
To make image or part of it transparent or semitransparent you have to use more sophisticated tool – Alpha Transparency Map.
It is usually Black & White picture where Black means Full transparent and White is opaque or it has the opacity    specified in the
Opacity box ( 0 – fully transparent, 1 - opaque)
You can switch on/off the alpha transparency by checking Enable Alpha Transparency check box.
If you don’t define the transparency map, but you enable the Alpha Transparency, the image will blend with the background with 
opacity defined in the Opacity edit box.
You can apply few useful effects on the transparency map – invert, make it grayscale and blur the map.
The typical usage of the transparency map is the Glow or Drop Shadow. The image is just rectangle with some color. The shape 
and the effect    is done by the transparency map.

If the Transparency map is smaller than Image – it will be tilled – you can use it for some nice effects.

Fill button – near the Color combo box.
You can fill whole image with single color defined in the color box. Great way how to change the color of the Glow or Drop 
shadow like objects.

You can make this object interactive by enabling the actions
For more info see the Actions .



Text Button
Create the standard Windows button. The button can have different fill and the color of the text.
It behaves the same way like standard windows button…
Actions
Text button is all the time active object. See the Actions .

Text Button Object can have Menu Item style.
Like that you can build your own Menu Groups.



Primitive Objects
Primitive objects can be active.

Rectangle 
It can have the fill and    the border    (Line), no border (None) or windows border – raised or sunken

Circle
The same like the rectangle object

Polygon
In this version of MMB has the polygon very limited functionality – it cannot be resized, but it can have different fill and the 
border. (or no border at all)

You can make this object interactive by enabling the actions
For more info see the Actions .

You can make nice multimedia application using only the primitive objects and text!



Group Object
Group object represents the group of the objects. See Groups for more info.
Opening the group properties you have the access to the grouped objects or another nested groups. To see the properties of the 
object just double click on it.

If you Hide the group all objects in the group will hide.



Clone
Clone object will inherit all graphic properties from its parent, but it can have different actions.
If you change the parent all clone objects will change the same way.

For example you create the bitmap button and then clone another five objects out of it.
If you later load another bitmaps into the parent all other five objects will change the look.

Clone tool save the space, but it is a bit slower to redraw.



Line
Line is inactive object, it cannot have any action.



Bitmap Button
You can create custom graphic button out of 3 images.
The normal Image, The Highlighted image if muse move over the button and the Click Image if mouse click on the button.

Refine Bitmap position:
You can change the relative position of highlight and click image to the normal image: To get easy nice effect or if the images 
doesn’t have the same origin.

All of the images can have one color transparent.

The color box will help you to define the background color with Automatic color . It is the top left pixel of the image.

You can save your buttons and make your own library for easy access later.

Bitmap buttons are essential part of all heavy graphic multimedia.

You can make this object interactive by enabling the actions.
For more info see the Actions .



Hot Spot
Hot Spot is active object.

Hot spot is invisible area you define on the screen where your viewer (user) can click or move mouse to make something 
happen. The area could be around a word, on the image etc.
Hot spot is invisible for viewer. However in the designer you see hot spots as an area with dashed border.



Video Object
Here are just properties of video object.

In order to play, stop or control the video you have to place other controls on the screen with assigned “Interaction with other objects
and Video” action.

AVI File
Video is external file, it will stay outside the mbd file.
It is essential to specify relative path to the file using <SrcDir> or <SrcDrive> commands in the path. 
You can do it later for all objects with “Replace Path” in Project menu.

More about relative paths in External Commands and Page Actions topic.

Hide Still Screen
Video if it is not playing is represented on the screen by the still image. However you can hide this still image.

Sound
You can disable sound if sound channel exist in AVI file
Note:
AVI Audio is playing through standard audio output and it cannot be played on the same time with DirectSound channels.
Just be aware the    video with sound    will shut down    DirectSound Channels and any background music will stop playing.
Shortly – the sound of video cannot be mixed with background sound.

Speed
MMB allows you to play video at any speed. The default value (normal speed) is 1000. Less than 1000 – the video will play 
slower and opposite.

Loop
Video can play in the loop until user trigger STOP action .

Save Still
Maybe you would like to save the still picture for the future or to use it somewhere else. This will be handy.

Load New
Load new AVI    file or reload the old one and select different still image.

 TIP: Wizard can insert video buttons for you.
After you create some video object, select it and click on wizard. Select “Create video controls”.
This will create few bitmap buttons attached to this video object.



Video Import
This dialog imports the AVI file and allows you to grab    the frame to represent video on the screen if this is not playing – the Still 
Image.
Just play or skip frames to the frame you would like to use as a still image and press OK.
Unfortunately capturing the still image from video doesn’t work under Windows 98. If you are designing the project under 
Windows 98 you have to put some other bitmap object over the video object. For playing the project there is no difference.
I believe this is a bug in Windows 98, because all other capturing software have the same result – cannot capture video frame 
under Win 98. (Hyper Snap, StripIt etc…)



Glow/Drop Shadow
This will create new object based on the parent object (bitmap with one color transparent, text or rectangle).
The Glow/DS object will be placed behind the parent object.

Label
String represents the new object.

Group with parent
New object will be grouped with parent after the new object is created.

Opacity
0 – 255. You can make Glow/DS more transparent by selecting value less than 255

Color
Color of the result Glow/DS object. Can be hanged later – see the TIP

Orientation – Offset X, Y
Glow has usually the position 0,0 relative to parent and Drop Shadow is usually shifted little bit right – bottom

Feather
How much diffuse will be the new object.
1 – the Glow/DS is almost sharp,
Bigger number – more blur

Direction
Direction of the diffusion

TIP:
Glow/DS object is a bitmap    object with alpha transparency map.

You can change color of the Glow/DS object any time later by opening the properties    - changing the color in color box and pressing
Fill button.

Don’t check the Transparent Color check box !

Wizard – You can make easy object that will glow if user move the mouse over the object.
Select the parent object (for example the Text), click Wizard icon on Toolbar and select “Glow on mouse move”. Now test the page 
and move mouse over the object. The object will glow.



Actions
Any one object can trigger on the same time three different kind of actions.

External Commands and Page Actions 
If user click on the object this action can    :

 Start an installation, run any external program, jump to your web page, send an email, open document, dislay help, run another 
MBD file, Browse the CD …
 Move between the pages of the MBD project
 Exit 

Interaction with other objects and Video 
Object can interact with other object on the same page. (show/hide object, play video) on user actions:

 Mouse move over the object
 Mouse click on the object

This action allows you to make professional look of your application (buttons glow when mouse move over …)

Sound Actions 
Object can play a sound if mouse move over the object and/or another sound if mouse click on the object.
Multimedia Builder supports multiple channels, so you can still play loop in the background without interrupting.



External Commands and Page Actions
You can use External Commands to launch an executable when your viewer click an interactive object (With Enabled actions)
Actions:

Run another project
This is a special action. It can run another MBD file project in the same window (like another page) or in separate window.
If the Second parameter is NEW_WINDOW the MBD file will be in separate window. If the second parameter is THIS_WINDOW 
the new MBD will be in the same frame – the user will think it is just another page.

If your project has a lot of graphics, it is a good idea to separate pages into different MBD files.
Multimedia Builder is designed primary for small projects – like Autorun Browsers etc. You can create bigger project, but you 
have to have different pages or groups of pages in a different MBD file, otherwise the MBD file will be very big.

Do not provide a fixed path unless you are certain that your application will reside in a specific directory on your viewer’s system.
Provide a relative path. The path is relative to the location of MMB player on your viewer’s system.
Use the <SrcDir> or <SrcDrive> to tell MMB to use actual directory where the player will be located on your viewer’s system or 
actual drive.

Example:

The player is named AUTORUN.EXE and it is located on a CD inside the INSTALL\ directory.
Let’s say the CD ROM is Drive D:\ on viewers system.
The command
<SrcDir>\BIN\INSTALL.EXE 
will be translated into
D:\INSTALL\BIN\INSTALL.EXE

And
<SrcDrive>\VIEWER\VIEWER.EXE
will become
D:\VIEWER\VIEWER.EXE

TIP:
You can change all paths to relative paths on the end of developing using Paths Replace in Project menu. During developing you
can use fixed paths just to make it running. After you finish you can run Check & Distribute files in Project menu and you will see 
list of errors if you are using fixed paths.

Page Actions
Only for Goto Page (Label)    you have to specify the Label of the page (example: Page 1)

External Commands can Run program, browse the disc, jump to the web page (you need to specify http:// and URL), send an 
Email through default Email client ( you need to specify mailto: and the email address) and much more…



Interaction with other objects and Video
Object can interact with other objects.
For example moving mouse over the text shows a glow behind the text…

Moving mouse: 
Show/Hide    - shows the object specified in Object list box and then hide it if mouse is not anymore over the object.
Show/Fade out – instead of simple hiding some object, the object will slowly fade out. The object must be only graphic object 
with Alpha transparency enabled.

Mouse click on object:
Show/Hide    – Show and then hide some object when user release mouse button.
Video actions on Video Object -    Play, Stop, Pause Skip, 2x slow or 2xfast
Show - Show an object or a group. This will stay until some object will hide it.
Hide - Hide an object or a group. This will stay until some object will show it.
Invert (Show-Hide) - Show or Hide an object or a group. If the object is hidden, this will show it and vice-versa.

Mouse click on object can trigger another action after the first one. 

For example the first action can hide the whole group and the second action can show one member of the group.
With two actions for mouse click and nested grouping you can create almost any efect.



Sound Actions
Moving mouse over the object or clicking on the object can trigger sound action.
The supported files are WAV files.
Wave files are external files and are not included into the MBD file. You have to provide relative path to the WAV file. See 
comments in External Commands 
Sound actions are all in Channel 2 if viewer use DirectSound or in the standard audio output without DirectSound.
Direct sound allows user to hear sounds without interrupting background music.

The On Click section can play instead of a Wave file the Audio track from Audio CD or Mixed-mode CD.
To use this function you will write instead of wave file name CD Audio command.
Commands:
CD:TrackNumber - will play desired track number. Note if you using Mixed mode audio the audio track will starts from 2.
(example CD:2)
CD:STOP - Stop playing
CD:PLAY - Start Playing – use after CD:PAUSE or CD:STOP
CD:FW - Play next track
CD:BW - Play previous track
CD:PLP - Play or Pause (the same action can play or pause playing)

As you can see you can build your own little CD player with Multimedia Builder.



Group Manager
Allows you to select objects by their name and group them into the group .



Page Properties
Label
Unique string represents this page

Background
Page can have solid background – defined by the color or bitmap background.
To load Bitmap as a background press Load Image button. If the image is smaller than the page size you can Tile the image. 
In directory Backgrounds are few nice backgrounds you can Tile.
If the page is not the first one you can copy all graphic properties from the first page.
The background graphic is very important. You should put as much bitmap graphics as you can into the background image. The 
redrawing of background is much faster than other objects.
You can combine objects with background:
Select the objects you would like to combine and from menu Arrange – select Combine – Objects with background.
From the next dialog select Delete source objects and    Use this image to create new background.

The page can use the background from first page or from Master Page.

Background music
MMB can on each page play different background music. 
The music can play across the page boundaries – if the next page has no background music the old one will still continue. 
Music can loop. There are tens of loops on the Internet or hundreds on special CD’s like Corel Stock Music Library.

Digital Audio
MMB has support for playing audio tracks from the CD. As the viewer enter the page the track can start play.
You will use this function to build your Mixed-mode CD where the first track is data track (your player and MBD data file and 
other data) and the other tracks are audio tracks.
Mixed mode CD’s are widely used for games and multimedia, because playing audio tracks doesn’t take so much resources like
playing WAVE files.

Note:
Background music is playing through DirectSound channel and it is mixed with other sound actions without interrupting.
The user has to have DirectSound, what is almost in 95% the case (in the future it will be 100% - Win95 SP 2 and Windows98 
has DirectSound by default)
Anyway MMB allows you to create Distribution Files, that are able to decide what player has to be used for users system. In 
worst case (user without DirectSound)    user will be not able to hear background music, but he will be able to hear Sound 
Actions (in that case the sound Actions are played through standard audio output). See Check Projects and Distribute Files .



Check Project and Distribute Files
On the end when you finish designing the multimedia application you would like to create distribution of your files.
This tool can help you to create proper distribution. 

Distribute
You have to select the location where you would like to copy all necessary files.
Select the location with Locate button. The standard windows dialog will allow you to create new directory if you like.

Player
Today 95% of users have DirectSound installed and in the near future everybody will have (it comes with new    Windows 95 and 
Windows 98).
But still to be sure – MMB has two players – for DirectSound and without DirectSound.
Standard
Use Standard if you don’t use any sound at all, or use only Sound Actions and you want to save some space.
Auto
If you use background music, or Sound Action the best choice is this options. Auto will copy both players and the file that will 
launch proper player regarding user system.
DirectSound only
Use this option if you need to have only DirectSound player. 
Be careful – users without DirectSound will be not able to play your application at all!

Checking the project
This tool checks the project against fixed paths for WAVE, AVI and other external files.
 (See comments about relative paths in    External Commands and Page Actions )
You can create distribution even if you have errors. You will be able to play application, you will have problems only with external 
files with fixed paths.

Resizing bitmaps and applying effect will create temporary bitmaps inside the project.
Those bitmaps are not necessary for distributing and removing them can significantly reduce the size of the project.

Stand Alone
Standard MMB output is the player and the MBD data file.
With Stand–Alone checked the compiler will produce only one single EXE file – the MBD data file will be linked inside the exe file.

Important Note:
Check Project and Distribute files doesn’t copy the external files (WAV, AVI or other external) to the distribution location. (They 
could be very big)
You will be informed after you press OK button.

In order to finish distribution of files you have to press OK.
The result message will pop-up.



Paths Replace
Wave files, AVI files and other external files (setup files etc..) are not part of the MBD file (they could be very big) and they will 
stay separate.
It is very important they have paths relative to the player on users system, not fixed paths.
(See comments about relative paths in    External Commands and Page Actions )
This tool allows you to change all paths in the project at once for Commands, Wave files and AVI files.

Search String
The string what will be replaced. Search for common string for example C:\WAVES

Replace With
Replace string with this one for example <SrcDrive>\WAVES

Replace Whole path
Whole path to the file will be replaced. Great if you don’t have sources with some part of the path common. (If you use sound 
files from all disks on your computer but on distribution disk you have to put them on one directory)
Example:
In project you use    Wave files
C:\Windows\sound.wav
D:\MSOffice\Ppoint\beep.wav

We put to Replace With string: <SrcDir>\WAVE
Check the Replace whole path and press Replace All
The result will be

< SrcDir >\WAVE\sound.wav
< SrcDir >\WAVE\beep.wav

Now you have to copy all wave files to your distribution place into directory WAVE

Replace All
This is the actual button to make the replace action. You cannot cancel this operation, so it will be nice to save the project before.

Note:
The commands, waves and video files are separate because it is good idea to put them also separate on distribution disk.
 For example:
All external files (Setup etc.) we will put to directory <SrcDir>\BIN
All wave files we will put to <SrcDir>\Waves
And all videos we will put to <SrcDir>\AVI

The <SrcDir> will be replaced on runtime with the actual directory of the player.

Note2:



Project Settings
Here your project start !

Window Size
Width and Height of the application window.

Window Title
The title (caption) will appear on the top of the Standard Window.

Standard Window
If checked window of your application will be standard window – with caption, border and close button
If unchecked – the window is custom window – no border, caption or close button are displayed. You can create your own 
artwork…

Client Border
A thin black border will be drawn in the client area of the window.
Very good if you need to add thin border to the window without any border (unchecked Standard Window).

Window has custom Shape
This unique feature moves MMB’s Non Standard window even further.
Window can have custom shape – or from library or from the Image.

Trace Shape from Image.
The image must be on solid background with enough space around, otherwise the tracer will not work properly.
You have to specify the start point, where the tracer will start. It should be in the background of the image.
The tracer tolerance allows you to specify closer shape. The value 0 – is no tolerance. 
The best is to create your background artwork on solid background – create the shape out of it with this tracer and then use the 
same image for background (in Page Properties )

If 256 colors detected
On runtime if MMB detect 256 color it can run another page (not the first one) or run another file or just continue.
On this separate page, or file you can optimize better graphics for 256 colors.

Direct Sound
You should leave this checked. DirectSound is a big advantage in speed and performance.
And even if    user doesn’t have direct sound, the MMB could run proper player.
See description in Page Properties..



Optimize the Speed and Colors
· Crop the Images to the size you really need.
· Put as much bitmap graphic as you can into the background – the background image redraws much faster than other objects.

The tool Combine objects with background in Arrange menu can help you.
· Big images with alpha transparency slowing down the application
· For 256 colors – you have palette.bmp file inside Palette directory.

You can use this image to extract palette inside your graphic editor. All your graphics should use colors from this palette. 
Convert your pictures in your graphic editor to 8 – bit    with using this palette.
For Corel Photo Paint    there is already palette prepared inside the MMB’s Palette directory.

· Reduce the size of the project. Click Reduce size from File menu. This will remove all unused temporary bitmaps from the 
project.



Windows Metafile
Windows Metafile (WMF) format is very popular vector format. You can export vector graphic (for example from CorelDraw) into 
the vector format. Metafile format can be scaled without loosing the quality.

MMB has support also for this format.
In this version are some restrictions: Metafile object cannot be active, it even doesn’t have properties. 

To place metafile object on the screen:
Select Metafile from the Object menu.
Draw rectangle on the screen, then Open dialog will appear. Select WMF file.
Resize the rectangle to desired size.



Comments
From menu File – Comments…
You can add comment to your project.
If you want this window open automatically after you open the project in designer check the check box “show next time on 
Open”.



What’s new?
05/AUG/98
MMB 1.3

New Object - Paragraph Text 
Paragraph text with word wrap and scroll bar. 

Master page and Master Top Layer 

CD Audio or Mixed-Mode CD support.
This is for those who wish to write their own CD-ROM and have access to a recordable CD drive.
In ver 1.3 each page can play different audio track from the CD.
Great for the Mixed-mode custom CD - on track 1 you have your programs, mmb player and data and on other
track you can put audio songs.

Objects can play Tracks from CD Audio
In the Sounds Actions you can write into the On Click box commands for CD Audio:
CD:2 - will play second track
CD:STOP - Stop Playing
CD:PLAY - Play 
CD:PAUSE - Pause
CD:FW - play next song
CD:BW - play prev. song
CD:PLP - Play/Pause

You can easy create simple CD player now. (see CDAudio.mbd sample)

Selection preview.
If you are interested how the objects you selected look like - the Selection view is for you.
To open/close selection view click on long button on the bottom part of Object List.
In the preview you can see hidden objects, groups and much more.
If you have heavy graphics and you think it is slowing down the designer - switch the preview off!
(It goes into the groups etc... so it may slow down the designer a bit.)

Stand Alone compiler is now part of the designer.

In the External Commands and page actions - The "Minimize" item was added.

23/07/98
MMB 1.2

Improved Object List
The group object can expand (tree like) to show objects (or groups) in this group.
The advantage:
- you can refine the position of the object in the group without 
    ungrouping the group. Just expand the group in the object list, 
    select the desired object and refine the position with the keyboard arrows.
- you can Remove object from group and move it outside the group. See Remove from Group;
- you can delete object inside the group without ungrouping the group

Better Tracker
The tracker - rectangle around the selected object was sometimes jumping to wrong position.
(If you open some dialog box) and now it is also visible on the black background.

Bug fix - DropShadow and Glow
This bug appear if you resize the rectangle of the bitmap and create drop shadow or glow.



Bug fix - change Label inside the group.
If you changed the Label of the object inside a group, the objects appeared unslectable or even invisible.

The Remove all effects in the menu Effects was renamed to Restore original.

New:
Add new Actions in "Interactive with other objects" for Mouse Click on the object

Show - Show an object or a group. This will stay until some object will hide it.
Hide - Hide an object or a group. This will stay until some object will show it.

Invert (Show-Hide)
Show or Hide an object or a group. 
If the object is hidden, this will show it and vice-versa.

Those actions allow you to create nice effects like menus etc. See NewMenu.mbd sample.
Note: One object can show/hide a nested group (Group1) inside another group (Group2). 
Another object can show/hide this group (Group2)... There is a lot of logic inside. See the demo.

New - Add to Group
In order to add an object to some existing group select the object 
hold down SHIFT and select the desired group. Click Add to Group button 
or from menu Arrange select Add to Group.
You can also add a group into another group the same way, but remember to select first
the object you want to add and then the group where you want to place the object.

New - Remove from Group
You can remove (ungroup) single object from the group. Select the object inside the group in 
the Object list and press Remove from Group button.

New - Scalable Bitmap Objects
Bitmap objects are now scalable. If you resize the bitmap object the image will resize as well.
You can return the image to the original anytime (even after you save) 
just clicking Restore Original from Effects menu.
Note: after you resize the image all effects (sharpen, blur, flip, gray scale) will be removed.
This is because MMB is trying to make the new resized image with the best possible quality. 
To preserve the ratio hold down Control when you resizing

New - Tile. (menu Effects)
After you resize the image you can apply this effect. If the new image is bigger than original the image 
will be tiled to the size of new image. If the new size is smaller the image will be cropped.
Note: if you resize the image again the tile effect will be removed.

New - Reduce size
Resizing bitmaps and applying effect will create temporary bitmaps inside the project.
Those bitmaps are not necessary for distributing and removing them can significantly reduce the size 
of the project.



Reduce size (File menu)
Resizing bitmaps and applying effect will create temporary bitmaps inside the project.
Those bitmaps are not necessary for distributing and removing them can significantly reduce the size 
of the project.

You should use this command if you are resizing the bitmaps or using effects before you distribute the files.



Crop
Cropping cuts away rectangular areas on an image without affecting the resolution or dimension of the area that remain.
To crop an image:
Select image object.
Select Crop from menu Effects
Draw rectangle inside image.

You can Restore the original image clicking Restore Original in menu Effects.

If you resize cropped image, the original image will be restored.
If you are satisfied with your new image then you can apply “Make new original” from menu Effects. After that you can resize the
new cropped image like it was original image.



Make new Original
Bitmap images leave original image as a temporary. Whenever you resize the image, the original image is resized. This 
preserves the best possible quality.
The same works for cropping and Tile – the full image before cropping or tilling is still remembered. If you resize the cropped or 
tilled    image – the original image will resize instead.
Make new Original replace the temporary original with the current image.
Then you can resize tilled image or cropped image like you would do with normal image.



Tile
To tile the image:
Resize image, It should be bigger than the previous.
Click Tile in menu Effects.
To apply Tilling you should use Make new Original.
Otherwise after resizing the original image will be restored.



Paragraph Text
Paragraph Text is automatic word-wrap toll for scrollable long text.
You just size your text rectangle on the screen and the text will fill the rectangle.
If the text is longer than visible rectangle, the Scroll Bar will appear.

Note:
User can scroll the text not only clicking on scroll bar but also clicking on text and moving mouse down or up. (the cursor will 
change to a hand)



Master Page properties
Master page can have a background. (The same as ordinary page)
To use this background in particular page you have to check Background – From Master Page on desired page. Otherwise the 
page will have its own background or background from the first page.



Master Page and Master Top Layer
This is very important feature if you have project with many pages.
You don’t want to copy all the common objects to all pages, do you?
Instead of this you can put the common objects to the Master Page or Master Top Layer.

What is the difference?

Master Page -  will appear as a bottom layer on each page. The objects on the page will appear all the time on the top of the 
objects from Master Page.
This is great to put your artwork here. Sure you can put also interactive objects here, but you must be sure other objects on 
pages will not cover them.

Master Top Layer – will appear as a top layer on each page. The objects on the page will be behind the Master Top Layer 
objects.
This is great for active objects like menus, buttons, windows, etc…




